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Preface

This guide contains the procedures and information system administrators need to 
install Oracle Communications Design Studio. 

To install and use Design Studio, system administrators must also install third-party 
software packages. Refer to the documentation distributed with the third-party 
packages for installation instructions.

Audience
This guide is intended for system administrators who use the preconfigured 
installation in the Design Studio software package to install the Design Studio feature, 
create a distributable archive file, and instruct individual users within an organization 
how to download and extract that preconfigured installation. Preconfigured 
installations simplify installation for individual users, reduce download times, and 
ensure correct installation.

Related Documents
For more information, see the following documents in the Design Studio 
documentation set:

■ Design Studio Concepts: Explains how to use Design Studio to manage and 
configure data for use across Oracle Communications service fulfillment products. 
This guide provides a conceptual understanding of Design Studio.

■ Design Studio System Administrator's Guide: Describes information about 
administering Design Studio. This guide includes information about configuring 
deployment settings for test environments, backing up and restoring Design 
Studio data, and automating builds.

■ Design Studio Developer’s Guide: Provides an overview of Design Studio platform 
tools, and information about working with design patterns, externally created 
schemas, and source control. Finally, it provides information about deploying to 
production environments. 

■ Design Studio Security Guide: Provides an overview of security considerations, 
information about performing a secure installation, and information about 
implementing security measures in Design Studio.

■ Design Studio Help: Provides step-by-step instructions for tasks you perform in 
Design Studio.
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Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support 
through My Oracle Support. For information, visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing 
impaired.

Document Revision History
The following table lists the revision history for this guide:

Version Date Description

F18562-01 June 2019 Initial release.
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1Design Studio Installation Overview

This chapter provides a general overview of installing Oracle Communications Design 
Studio.

Overview of the Design Studio Installation Procedure
To install Design Studio, you download and unzip an archive file, which contains (but 
is not limited to) the Design Studio feature and a preconfigured update site.

The installation procedure follows these steps:

1. Review the system requirements.

Ensure that your installation meets the minimum hardware, software, operating 
system, and JDK version requirements. See "Design Studio System Requirements" 
for more information.

2. Perform the pre-installation tasks.

Before installing Design Studio, you must install the prerequisite software. See 
"Installing Prerequisite Software" for more information.

3. Create and distribute a preconfigured Design Studio environment.

Provide your Design Studio users with a preconfigured installation for quick 
installation. See "Installing and Configuring Design Studio" for more information 
about obtaining the Design Studio software package, configuring the installation, 
and working with the preconfigured environment. 

About the Design Studio Software Package
The Design Studio software package is an archive file that you download from the 
Oracle software delivery website. The Design Studio software package includes the 
following:

■ A preconfigured update site, which includes the Design Studio feature. The 
Design Studio feature includes Design Studio Platform and all product features 
and plug-ins.

The update site folder structure is compatible with the Eclipse Software Update 
feature. See "About Update Sites" for more information.

■ Sample command-line build scripts.

■ Application software developer’s kit (SDK) functions, which provide the resources 
required to configure a project library list and to build Oracle Communications 
Order and Service Management (OSM) application projects in Design Studio. For 
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more information about the OSM SDK, see OSM Developer’s Guide available at the 
Oracle Help Center.

■ Cartridge Management Tool scripts and OSM migration scripts.

■ Installation scripts (for Windows and Linux) that you can run to automatically 
install the Design Studio feature and to configure the Design Studio environment. 
When you run the script, you will provide the JDK and OEPE bundle locations 
and the middleware home location (for example, Oracle WebLogic Server 12c). 
Optionally, you can provide the updated site details for the Business Intelligence, 
Reporting, and Charting feature (BIRT), Graphical Editing Framework Zest 
Visualization Toolkit feature, SDK location from UIM application installation, and 
SDK location from NI application installation.

Oracle recommends that system administrators, when installing all new releases and 
patches, obtain a new Design Studio software package, perform a new installation, 
and distribute a new preconfigured installation to all Design Studio users. This 
method ensures that all users in the organization upgrade simultaneously and that all 
users are working with the identical platform, Java, and Design Studio feature 
versions.

About Update Sites
Design Studio installations require an update site. An update site is a repository of 
Design Studio features and their supporting plug-ins, and uses a specific format that 
works with the Eclipse update manager. The update site is a preconfigured set of 
directories in the update folder, which includes the artifacts.jar and the content.jar 
files. These JAR files identify the features and supporting plug-ins available in the 
update site.

Oracle recommends that system administrators use the update site packaged in the 
Design Studio software package.

Note: System administrators must ensure that the individual Design 
Studio users all work with the same version of Design Studio. 
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2Design Studio System Requirements

This chapter lists the minimum system requirements necessary for individual Design 
Studio users to successfully install and run Oracle Communications Design Studio.

See "Hardware Sizing Guidelines" for information about hardware sizing 
recommendations.

Software Requirements
This section describes the software requirements required to install and use Design 
Studio.

Operating System Requirements
Table 2–1 lists the operating systems supported by Design Studio.

Additional Software Requirements
Table 2–2 lists the additional software required to install and use Design Studio.

Table 2–1 Operating System Requirements

Product Version

Windows 7 64-bit

Windows 10 64-bit

Table 2–2 Additional Software Requirements

Product Version

Oracle Enterprise Pack for 
Eclipse

Version 12.2.1.9 (or later), based on Eclipse Photon (4.8.0) 

Java SE JDK Java 8 (use the latest service pack)

Eclipse Business 
Intelligence, Reporting, and 
Charting feature

Eclipse Photon (4.8.0)

Eclipse Graphical Editing 
Framework Zest 
Visualization Toolkit 
feature 

Eclipse Photon (4.8.0)
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Hardware Requirements
Table 2–3 lists the minimum hardware required to install and use Design Studio.

Application performance is directly related to processor performance and memory. For 
larger projects, consider increasing the processor power and the initial memory and 
maximum memory settings for the Java heap size.

Design Studio Product Compatibility
Design Studio is compatible with specific Oracle Communications applications 
releases. The Design Studio Product Compatibility Matrix is available on the Oracle Help 
Center. For more information, click the link below, then click the appropriate release:

http://docs.oracle.com/en/industries/communications/design-studio/index.ht
ml

Design Studio Feature Dependencies
The Design Studio installation is an aggregation of individual features. When you 
install Design Studio, you install the full feature set (you do not install individual 
features). The following Design Studio individual features are included in the 
installation: 

■ Design Studio Platform

■ Design Studio Domain Modeling

■ Design Studio for Activation

■ Design Studio for Activation SRT

■ Design Studio for IP Service Activator

■ Design Studio for Order and Service Management

■ Design Studio for Order and Service Management Orchestration

■ Design Studio Integration (includes the Design Studio Activation Task feature)

■ Design Studio for Network Integrity

■ Design Studio for Unified Inventory Management

■ Oracle Communications Design Studio Design Pattern

■ Oracle Communications Design Studio Guided Assistance

■ Oracle Communications Design Studio Reference Reports

Table 2–3 Minimum Hardware Requirements

Component Requirement

Processor Minimum Intel dual core (or equivalent)

Memory Recommended 8 GB or above

Monitor Screen Resolution:

■ Recommended: Full HD (1920x1080), 32-bit color, 16:9 ratio

■ Minimum: 1366x768 or 1280x800

http://docs.oracle.com/en/industries/communications/design-studio/index.html
http://docs.oracle.com/en/industries/communications/design-studio/index.html
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3Installing Prerequisite Software

[2] This chapter describes the software that you are required to install before installing 
Oracle Communications Design Studio.

About Installing Prerequisite Software
Before installing Design Studio, do the following:

1. Install Oracle Enterprise Pack for Eclipse.

See "Installing Oracle Enterprise Pack for Eclipse" for more information.

2. Download the Java SE JDK.

Download the Java 8 version that matches the Oracle Enterprise for Eclipse 
version. For example, if you installed the Oracle Enterprise for Eclipse 32-bit 
version, then install the Java 8 32-bit version; a 64-bit Oracle Enterprise for Eclipse 
version requires a 64-bit Java version.

Download the latest update of JDK 8 for the required platform from the Oracle 
Technology Network Web site:

http://www.oracle.com/technetwork/java/javase/downloads/index.html

3. Install the Java SE JDK.

For information about installing the JDK, see the JDK installation documentation:

http://docs.oracle.com/javase/8/docs/technotes/guides/install/install_
overview.html

4. Copy the Java environment into Oracle Enterprise Pack for Eclipse.

See "Copying Java Runtime Environment into Oracle Enterprise Pack for Eclipse" 
for more information.

5. Configure the Eclipse startup properties.

See "Configuring Eclipse Startup Properties" for more information. 

6. Verify the Eclipse installation.

See "Verifying the Eclipse Installation" for more information. 

Note: The following setup instructions are intended for system 
administrators. Individual Design Studio users should contact an 
administrator for instructions on obtaining and installing a 
preconfigured archive file.

http://www.oracle.com/technetwork/java/javase/downloads/index.html
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7. Locate the Oracle WebLogic Server installation directory.

The Design Studio installation script requires you to define the MIDDLEWARE_
HOME variable (for example, C:\Oracle\Middleware) and the WEBLOGIC_
HOME variable (for example, C:\Oracle\Middleware\wlserver). Additionally, 
Order and Service Management users require access to Oracle WebLogic Server 
libraries when building cartridge projects in Design Studio. 

When defining these variables, you can point to an existing installation, or you can 
copy the libraries required by Design Studio and include those directories in your 
local Design Studio installation. If copying, copy all of the files and folders in the 
Oracle Fusion Middleware home directory (for example, C:\Oracle\Middleware), 
and paste those files into a local Fusion Middleware home directory (such as 
C:\Oracle\Middleware).

See the OSM Installation Guide for information about which version of Oracle 
WebLogic Server you require. The OSM Installation Guide is available on the Oracle 
Help Center:

http://docs.oracle.com/en/industries/communications/order-service-manag
ement/index.html

See the Oracle Fusion Middleware page on Oracle Help Center for information 
about installing Oracle WebLogic Server:

http://docs.oracle.com/en/middleware/middleware.html

8. Do one of the following:

■ Install the prerequisite features using the Eclipse user interface.

See "Installing the Business Intelligence, Reporting, and Charting Feature" and 
"Installing the Graphical Editing Framework Zest Visualization Toolkit 
Feature" for more information.

■ Download the prerequisite features for offline installation. See "Downloading 
Prerequisite Features for Offline Installation" for more information.

Installing Oracle Enterprise Pack for Eclipse
To download and install Oracle Enterprise Pack for Eclipse:

1. Go to the Oracle Technology Network website:

http://www.oracle.com/technetwork/developer-tools/eclipse/downloads/ind
ex.html

2. Read and accept the license agreement, then select the Windows (64-bit) link.

Note: Do not install an Oracle WebLogic Server domain specifically 
for Design Studio.

Note: The Oracle Technology Network website is occasionally 
updated with new versions of Oracle Enterprise Pack for Eclipse. If 
you are looking for a version previous to the one that appears here, 
click the Oracle Enterprise Pack for Eclipse Previous Releases link at 
the bottom of the page. 

http://docs.oracle.com/en/industries/communications/order-service-management/index.html
http://docs.oracle.com/en/industries/communications/order-service-management/index.html
http://docs.oracle.com/en/middleware/middleware.html
http://www.oracle.com/technetwork/developer-tools/eclipse/downloads/index.html
http://www.oracle.com/technetwork/developer-tools/eclipse/downloads/index.html
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3. Download the archive file to an installation location and unzip the file.

For example, unzip the file into a new directory called DesignStudio. In this guide, 
subsequent references to this directory refer to this location as Eclipse_Home.

Copying Java Runtime Environment into Oracle Enterprise Pack for 
Eclipse

To copy the Java 8 Runtime Environment into Oracle Enterprise Pack for Eclipse:

1. Locate the Java SE SDK installation folder.

The Java self-installing executable file defines the default installation location as 
c:\Program Files\Java. 

2. Copy the jre1.8n folder (for example, jre1.8.0_121) into the Eclipse_Home folder, 
where Eclipse_Home is the directory in which Oracle Enterprise Pack for Eclipse is 
installed.

The jre1.8n folder must be copied to the same location where the eclipse.exe file is 
saved. 

3. Rename the jre1.8n folder to jre.

Configuring Eclipse Startup Properties
System administrators control Eclipse startup by configuring properties in the 
eclipse.ini file, located in the Eclipse root directory. By editing eclipse.ini, system 
administrators can:

■ Define the initial amount of memory for the Java heap size. 

A heap is the common pool of free memory available to a program. If Eclipse is 
using more memory than is available, increase the heap size allocated by the JVM 
to Eclipse. Increasing the heap size may eliminate OutOfMemoryError instances 
when Eclipse attempts to instantiate objects. 

To define the initial amount of memory the JVM allocates to Eclipse, use the -Xms 
setting. 

Note: Oracle Mobile Application Framework (MAF) supports 
application development for iOS and Android. Design Studio does not 
require MAF. Select the MAF bundle only if you require iOS and 
Android application development support in your Eclipse installation.

Note: If Eclipse does not locate the jre1.8n folder in the Eclipse_Home 
directory, it attempts to find the jre1.8n folder using the JAVA_HOME 
windows environment variable. 

Oracle recommends that you save a version directly in the Eclipse_
Home directory to ensure that individual Design Studio users run 
Design Studio with a supported Java version. Saving the Java version 
to JAVA_HOME does not ensure that individual users will run Design 
Studio with a supported Java version, and the Java version may be 
changed by installations initiated by other programs.
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■ Define the maximum amount of memory for the Java heap size. 

To define the maximum amount of memory that the JVM can allocate to Eclipse, 
use the -Xmx setting. Consider the following guidelines:

– For individual users working on a 64-bit version of Eclipse on Windows 
(64-bit), you can define the maximum memory values higher than 1024 MB, 
enabling full use of available memory. For example, if an individual Design 
Studio user runs Eclipse on a 4 GB machine running Windows (64-bit), you 
can define the -Xmx option up to -Xmx3096m.

– If out-of-memory errors occur at startup (because of an increase to the 
maximum allocated heap that the operating system is unable to support), close 
Design Studio, reduce the -Xmx value, and reopen Design Studio. Oracle 
recommends reducing the value gradually to ensure that Design Studio starts 
with the greatest heap space possible.

In the following example, a system administrator configures the eclipse.ini file 
settings for machines with at least 4 GB of memory: 

Example 3–1 eclipse.ini File

-startup
plugins/org.eclipse.equinox.launcher_1.3.0.v20130125-144918.jar
--launcher.library
plugins/org.eclipse.equinox.launcher.win32.win32.x86_64_1.1.200.v20130117-173747
-showsplash
org.eclipse.platform
--launcher.defaultAction
openFile
--launcher.appendVmargs
-vmargs
-XX:NewRatio=5
-XX:+UseAdaptiveSizePolicy
-XX:+UseParallelGC
-Xms128m
-Xmx1024m
-Dsun.lang.ClassLoader.allowArraySyntax=true

For more information about the eclipse.ini file, see:

http://wiki.eclipse.org/Eclipse.ini 

Verifying the Eclipse Installation
To verify that the Eclipse platform installed successfully: 

1. Double-click the eclipse.exe file.

The Workspace Launcher dialog box appears.

2. Specify a workspace. 

You can select a temporary folder or accept the default location. However, each 
individual Design Studio user should identify the appropriate working directory 
on their local machine. To help Design Studio users identify in which directory 
configuration information should be stored on their computer, system 
administrators can specify in the Workspace Launcher dialog box a location where 
most users will want to place their configuration files. The directory and folder 
structure that the installation administrator specifies in this step will become the 
default value for the Workspace field in the Workspace Launcher.
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3. Click OK.

The Welcome screen appears.

4. Select Help, then About Eclipse Platform.

5. Verify the Eclipse version.

Installing the Business Intelligence, Reporting, and Charting Feature
You install the Business Intelligence, Reporting, and Charting feature (BIRT) to 
develop report designs and generate reports that Design Studio users can use to 
review detailed information about an implemented solution. For example, you can 
design reports that capture the name, type, description, and relationships of projects, 
entities, and data elements. Design Studio users can generate these reports and share 
solution modeling information among team members.

To install the Business Intelligence, Reporting, and Charting feature: 

1. In the Oracle Enterprise Pack for Eclipse application, from the Help menu, select 
Install New Software.

The Available Software dialog box appears.

2. In the Work with field, click the menu and select the following update site:

Photon - http://download.eclipse.org/releases/photon

A list of features available from the site appears.

3. Select Business Intelligence, Reporting and Charting.

4. Click Next.

The Install Details dialog box appears.

5. Review the installation details.

6. Click Next.

The Review Licenses dialog box appears. 

7. Review and accept the license agreement.

8. Click Finish. 

9. When prompted, click Yes to restart Eclipse.

Installing the Graphical Editing Framework Zest Visualization Toolkit 
Feature

The Graphical Editing Framework Zest Visualization Toolkit feature is not included in 
Oracle Enterprise Pack for Eclipse. This feature is a prerequisite that you must install 
before you install Design Studio.

Note: This procedure requires internet access. You can install BIRT 
offline using the Design Studio installation build.properties file.

See "Downloading Prerequisite Features for Offline Installation" for 
information about installing BIRT offline.
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1. Open the Oracle Enterprise Pack for Eclipse application.

2. From the Help menu, select Install New Software.

The Install dialog box appears. 

3. In the Work with field, enter the following:

http://download.eclipse.org/tools/gef/updates/legacy/releases/

4. Press the Enter key.

5. Expand GEF (Graphical Editing Framework) and select Zest.

6. Click Next and accept the terms of the license agreement.

7. Click Finish.

8. Restart Eclipse.

Downloading Prerequisite Features for Offline Installation
The Graphical Editing Framework Zest Visualization Toolkit feature and the Business 
Intelligence, Reporting, and Charting feature are not included in Oracle Enterprise 
Pack for Eclipse. These features are prerequisites that you must install before you 
install Design Studio.

If you will not have internet access during installation, you can download these 
features and install them later when you are offline.

To download the prerequisite features for offline installation: 

1. Navigate to the BIRT All Downloads page by identifying the compatible BIRT 
version for Eclipse Photon from the URL:

https://projects.eclipse.org/releases/photon

2. Scroll down to the Zipped P2 repository section.

3. Download and save the Zipped P2 repository file:

■ If the Zipped P2 repository file is available, click Download, save the Zipped 
P2 repository file and extract it to a shared location.

■ If the Zipped P2 repository file is not available or Download is not enabled, 
see "Downloading Prerequisite BIRT Features Using an Ant Script for Offline 
Installation" for more information.

4. Navigate to the following Eclipse download page:

http://www.eclipse.org/downloads/download.php?file=/tools/gef/downloads
/drops/legacy/4.0.0/R201606061308/GEF3-Update-4.0.0.zip

5. Click the GEF3-Update-4.0.0.zip file to download the file.

6. Extract the GEF3-Update-4.0.0.zip file to a shared location.

7. Install the features offline using the Design Studio installation scripts.

Note: This procedure requires internet access. You can install this 
feature offline using the Design Studio installation build.properties 
file.

See "Downloading Prerequisite Features for Offline Installation" for 
more information.

http://www.eclipse.org/downloads/download.php?file=/tools/gef/downloads/drops/legacy/4.0.0/R201606061308/GEF3-Update-4.0.0.zip
http://www.eclipse.org/downloads/download.php?file=/tools/gef/downloads/drops/legacy/4.0.0/R201606061308/GEF3-Update-4.0.0.zip
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You can specify the shared location of the extracted GEF3-Update-4.0.0.zip file 
and of the extracted BIRT Zipped P2 repository file in the Design Studio 
installation build.properties file.

See "Installing and Configuring Design Studio" for more information about 
updating the build.properties file and running the installation script.

Downloading Prerequisite BIRT Features Using an Ant Script for Offline 
Installation

You can download the BIRT Zipped P2 repository file for offline installation by 
running an Ant script. Save the following Ant script as an XML file.

Example 3–2 Ant script

<project default="birt-updatesite"> 
<property name="destinationFolder" value="C:/birt_p2_repo"/> 
<target name="birt-updatesite"> 
  <p2.mirror> 
    <repository 
location="${destinationFolder}/${ant.project.invoked-targets}"/> 
    <source> 
      <repository location="http://download.eclipse.org/releases/photon"/> 
    </source> 
    <slicingOptions followStrict="false" /> 
       <iu id="org.eclipse.birt.feature.group"/> 
<iu id="org.eclipse.birt.report.designer.editor.xml.wtp.feature.group"/> 
<iu id="org.eclipse.birt.chart.cshelp.feature.group"/> 
<iu id="org.eclipse.birt.cshelp.feature.group"/> 
<iu id="org.eclipse.birt.doc.feature.group"/> 
<iu id="org.eclipse.birt.example.feature.group"/> 
  </p2.mirror> 
</target> 
</project> 

To download BIRT features using an Ant script for offline installation: 

1. Open the Oracle Enterprise Pack for Eclipse application.

2. Open the required project.

3. Copy the Ant script XML file in to any folder within the project.

4. Open the Ant view. 

5. Open the Context menu by right-clicking the page.

6. Select Add Buildfiles.

The Buildfile Selection page appears.

7. Navigate to the Ant script XML file.

Note: Always run the Ant script from Eclipse.

Run the script in the JRE of the workspace. This process allows the 
script to access P2 tasks (for example, p2.mirror).

Change destinationFolder to a required folder before running the 
script.
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The Ant script build file appears in the Ant view.

8. Open the Context menu by right-clicking the build file.

9. Select Run As > Ant Build....

The Edit Configuration page appears.

10. Navigate to the JRE tab.

11. Select Run in the same JRE as the workspace.

12. Click Apply and then Run.

The repository file is created in the destination folder provided in Ant script.

13. Copy the repository file and save it to a shared location.

14. Continue with step 4 in "Downloading Prerequisite Features for Offline 
Installation".
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4Installing and Configuring Design Studio

This chapter provides information about installing Oracle Communications Design 
Studio. Oracle recommends that system administrators create a preconfigured 
installation and distribute that installation to individual Design Studio users.

Creating and Distributing Design Studio Preconfigured Installations
To create preconfigured installations for individual users to download and install, 
system administrators:

1. Obtain the Design Studio software package file and save to a temporary location.

■ The Design Studio software package for new releases are available on the 
Oracle software delivery website:

http://edelivery.oracle.com

■ The Design Studio software package for patches are available on the My 
Oracle Support website:

https://support.oracle.com

2. Open the Oracle Enterprise Pack for Eclipse application.

3. Run the Design Studio installation script.

The Design Studio installation script: 

■ Installs the Business Intelligence, Reporting, and Charting feature (BIRT) and 
the Graphical Editing Framework Zest Visualization Toolkit feature if you 
have not previously installed these features and if you have defined the 
corresponding properties in the build.properties file with values specific to 
your environment.

■ Automatically installs the Design Studio feature.

■ Configures the Design Studio environment.

See "Running the Design Studio Installation Script" for more information.

4. Import required base projects into the workspace.

Note: You can install the Design Studio feature and configure the 
environment without running the installation script. For more 
information, see "Installing the Oracle Communications Design Studio 
Feature" and "Configuring Design Studio as the Primary Application".
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If you added the UIM_SDK_LOCATION and NI_SDK_LOCATION parameters 
in build.properties file, the cartridges folder is available at the root level of Design 
Studio. If you ran an installation script to automatically install the Design Studio 
feature, the base projects are located in the cartridges folder at the root level of the 
Design Studio installation (defined in the DESIGN_STUDIO_HOME variable). 
See application documentation for more information about required base projects. 
See the Design Studio Help at the Oracle Help Center for information about 
importing projects:

http://docs.oracle.com/en/industries/communications/design-studio/index
.html

5. (Optional) Install custom report designs.

See "Installing Custom Reports" for more information. 

6. Configure the automatic update preferences.

System administrators disable access to the update site and to automatic update 
functionality to prevent Design Studio users from updating to different feature 
versions. See "Configuring Update Preferences" for more information.

7. Create an archive file containing the Eclipse folder and all subdirectories.

8. Instruct individual Design Studio users to download and extract the distributable 
archive file.

9. Instruct individual users to define their local MIDDLEWARE_HOME variable 
and WEBLOGIC_HOME variable with the same values defined for these 
variables in the build.properties file.

Users need to update these variables only if they have defined them locally at a 
location different than the path defined in the build.properties file.

Users define these values in the Design Studio Preferences page. See the Design 
Studio Help for more information about defining Order and Service Management 
and Application Integration Architecture (AIA) preferences.

10. Instruct individual Design Studio users working with Network Integrity projects 
to configure the MIB directory. 

For information about defining Network Integrity preferences in Design Studio, 
see Network Integrity Developer's Guide.

11. Instruct individual users creating custom Web services for Unified Inventory 
Management (UIM) projects to complete the required preliminary setup. 

See UIM Web Services Developer's Guide for more information.

Running the Design Studio Installation Script
The Design Studio software package includes installation scripts that you can run to: 

■ Install the Business Intelligence, Reporting, and Charting feature (BIRT) and the 
Graphical Editing Framework Zest Visualization Toolkit feature if you have not 
previously installed these features and if you have defined the corresponding 
properties in the build.properties file with values specific to your environment.

■ Automatically install the Design Studio feature.

■ Configure the Design Studio environment.

http://docs.oracle.com/en/industries/communications/design-studio/index.html
http://docs.oracle.com/en/industries/communications/design-studio/index.html
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To automatically install the Design Studio feature and to configure the Design Studio 
environment:

1. Close the Oracle Enterprise Pack for Eclipse application.

2. Navigate to the Design Studio software package that you downloaded from the 
Oracle software delivery website.

3. In the root folder, open the build.properties file.

4. Modify the following properties with values specific to your environment:

■ DESIGN_STUDIO_WORKSPACE, which identifies the location of Design 
Studio workspace directory in which your model configuration will be saved 
(for example, C:/DesignStudio/7.4.1). Design Studio automatically creates this 
workspace at the location that you specify.

■ DESIGN_STUDIO_HOME, which identifies the directory to which the 
application SDK functions and base projects are available only if either UIM, 
NI, or both location properties are provided (for example, 
C:/DesignStudio/7.4.1). This root directory will contain the application SDK 
functions and base projects on completion of the script.

■ WEBLOGIC_HOME, which identifies the location of your Oracle WebLogic 
Server installation (for example, C:/Oracle/Middleware/Oracle_
Home/wlserver). 

■ MIDDLEWARE_HOME, which identifies the location of the Oracle Fusion 
Middleware installation (for example, C:/Oracle/Middleware/Oracle_Home).

■ BIRT_UPDATE_SITE, which identifies the location where the BIRT P2 
repository is extracted. This property is required only when installing the 
Business Intelligence, Reporting, and Charting feature offline and only if the 
feature was not previously installed into OEPE_ECLIPSE_HOME. See 
"Downloading Prerequisite Features for Offline Installation" for information 
about obtaining this feature.

■ GEF_LEGACY_UPDATE_SITE, which identifies the location where the 
Graphical Editing Framework Zest Visualization Toolkit feature is extracted. 
This property is required only when installing Design Studio offline and only 
if the feature was not previously installed into OEPE_ECLIPSE_HOME. See 
"Downloading Prerequisite Features for Offline Installation" for information 
about obtaining this feature.

■ UIM_SDK_LOCATION, which identifies the location of UIM_SDK.zip from 
UIM application installation. This property is required only if you want to 
configure UIM SDK functions and to have UIM base projects in the Design 
Studio installation (DESIGN_STUDIO_HOME).

■ NI_SDK_LOCATION, which identifies the location of Network_
Integrity-NetworkIntegritySDK-version-generic.zip from NI application 
installation, where version refers to the NI version. This property is required 
only if you want to configure NI SDK functions and to have NI base projects 
in the Design Studio installation (DESIGN_STUDIO_HOME).

Note: When defining variables in the following procedure, do not 
use back slashes or spaces in the path names. Use forward slashes 
instead of back slashes.
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5. Do one of the following:

■ For Windows installations, right-click the install.bat file, select Edit, and 
change the values for the OEPE_ECLIPSE_HOME and JAVA_HOME 
variables to be specific to your installation environment. The JAVA_HOME 
variable must point to the JDK folder. For example:

JAVA_HOME=C:/Program Files/Java/jdk1.8.0_66

OEPE_ECLIPSE_
HOME=C:/DesignStudio/7.4.1/oepe-birt-photon-12.2.1.9-win32-x86_64.zip

Run the install.bat batch file to install the Design Studio feature and to 
configure the environment.

■ For Linux installations, edit the OEPE_ECLIPSE_HOME, JAVA_HOME, and 
ANT_HOME variables in the install.sh file to be specific to your environment, 
and then run the install.sh file to install the Design Studio feature and to 
configure the environment. 

6. Open Design Studio.

If the installation script completed successfully, the product branding on the 
splash screen is changed from Oracle Enterprise Pack for Eclipse to Oracle Design 
Studio.

7. In the Workspace Launcher dialog box Workspace field, verify that the path name 
points to the workspace identified by the DESIGN_STUDIO_WORKSPACE 
variable.

8. Click OK.

The Design Studio feature is now installed, and the environment is configured with:

■ A workspace, as defined by the DESIGN_STUDIO_WORKSPACE variable 
(assuming a workspace with the same name did not pre-exist).

■ Class path variables and a Java compliance level (1.8), as defined by variables you 
defined:

– The Oracle WebLogic Server home, as defined by the WEBLOGIC_HOME 
variable: WL_LIB=${WEBLOGIC_HOME}/lib

– The UIM SDK home: UIM_LIB=${DESIGN_STUDIO_HOME}/sdk/UIM/lib

– The Oracle Fusion Middleware home, as defined by the MIDDLEWARE_
HOME variable: ORACLE_MIDDLEWARE_HOME=${MIDDLEWARE_
HOME}

Note: Running the installation script deletes any existing sdk and 
cartridges folders from DESIGN_STUDIO_HOME. If you do not 
provide the UIM_SDK_LOCATION and NI_SDK_LOCATION 
properties, you will lose the SDKs and cartridges for UIM and NI.

Note: Design Studio displays an error if the installation file cannot 
locate the Business Intelligence, Reporting, and Charting feature or if 
the installation file cannot locate the Graphical Editing Framework 
Zest Visualization Toolkit feature.
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– The Java SDK home, as defined by the JAVA_HOME variable.

– The OSM SDK home: OSM_SDK_HOME=${DESIGN_STUDIO_
HOME}/sdk/OSM

■ The application SDK functions and base projects are installed to the sdk folder at 
the root directory of the Design Studio home path, as defined by the DESIGN_
STUDIO_HOME variable. The sdk folder includes SDK functions required to 
configure a project library list and to build Order and Service Management (OSM) 
application projects in Design Studio.

■ A cartridges folder is installed at the root directory of the Design Studio home 
path, as defined by the DESIGN_STUDIO_HOME variable. This cartridges 
folder is available only if either UIM, NI, or both SDK location properties are 
included in the build.properties file.The cartridges folder includes UIM base 
projects and Network Integrity base projects.

Design Studio is compatible with specific Oracle Communications application releases. 
For more information, see the Design Studio Product Compatibility Matrix on the Oracle 
Help Center. Click the link below, then click the appropriate release:

http://docs.oracle.com/en/industries/communications/design-studio/index.ht
ml

Installing the Oracle Communications Design Studio Feature
System administrators install the Oracle Communications Design Studio feature into 
the preconfigured installation and provide users with an archive file prepopulated 
with this feature.

To install the Oracle Communications Design Studio feature:

1. Start Design Studio.

2. From the Help menu, select Install New Software.

The Available Software dialog box appears.

3. Enter the location where you extracted the Design Studio archive file update 
folder.

Do one of the following:

■ In the Work with field, enter the URL that describes the location where you 
extracted the Design Studio archive file update folder. For example:

file:///folder1/folder2/

■ Click the Add button, then click the Local button to navigate to the location of 
to select the update folder. 

After you specify the URL, the list of features available at that location appears. 

4. Select Oracle Communications Design Studio.

5. (Optional) Select Oracle Communications Design Studio Reference Reports.

Note: Complete this procedure if you did not run the installation 
script to automatically install the Design Studio feature and to 
configure the Design Studio environment.

http://docs.oracle.com/en/industries/communications/design-studio/index.html
http://docs.oracle.com/en/industries/communications/design-studio/index.html
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Install the Oracle Communications Design Studio Reference Reports feature if 
you want the installation to include Design Studio reference report designs. 
Design Studio includes a set of reference report designs that provide a 
foundational set of capabilities. You can use these report designs as is or as a 
starting point for customizing your own reports. For example, you can customize 
the report designs for content, layout, or branding.

Before you can install the Oracle Communications Design Studio Reference 
Reports feature, you must first install the Business Intelligence, Reporting and 
Charting feature. See "Installing the Business Intelligence, Reporting, and 
Charting Feature" for more information.

6. Deselect the Contact all update sites during install to find required software 
option.

7. Click Next.

The Install Details dialog box appears.

8. Review the installation details.

9. Click Next.

The Review Licenses dialog box appears. 

10. Accept the license agreement.

11. Click Finish. 

12. When prompted, click Yes to restart Eclipse.

13. Verify the installation.

See "Verifying Design Studio Feature Installation" for more information. 

14. Instruct individual Design Studio users to configure all applicable Oracle 
WebLogic Server, Java, and SDK home directories.

Individual Design Studio users working with Order and Service Management 
(OSM) projects must configure the Oracle WebLogic Server, Java, and SDK home 
directories. For information about defining OSM general preferences, see the 
Modeling OSM Processes Help in Design Studio.

Individual users extending the data model for Unified Inventory Management 
projects must complete the required preliminary setup. See UIM Developer's Guide 
for more information.

Installing Custom Reports
If you have developed your own report designs using the BIRT report designer, and if 
you have packaged the designs into features using the guidelines described in the 
Design Studio Developer’s guide, you can select the features for installation. After 
installation, your custom reports will appear in the list of available reports in the 
Design Studio Generate Reports wizard. See the Design Studio Developer’s Guide for 
more information about developing custom reports.

1. Start Design Studio.

2. From the Help menu, select Install New Software.

The Available Software dialog box appears.

3. Enter the location where you saved the update site that includes your customer 
report design feature.
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Do one of the following:

■ In the Work with field, enter the URL that resolves to the folder representing 
the update site. For example:

file:///folder1/folder2/

■ Click the Add button, then click the Local button to navigate to the location of 
the update site with the custom report design feature.

After you specify the update site location, the list of features available at that 
location appears.

4. (Optional) Select the feature that includes your custom report designs.

5. Deselect the Contact all update sites during install to find required software 
option.

6. Click Next.

The Install Details dialog box appears.

7. Review the installation details.

8. Click Next.

The Review Licenses dialog box appears. 

9. Review and accept the license agreement.

10. Click Finish.

11. If prompted, click OK to confirm the installation of unsigned content.

12. When prompted, click Yes to restart Eclipse.

Configuring Design Studio as the Primary Application
System administrators can edit the eclipse.ini file and the config.ini file to change the 
product branding from Eclipse to Design Studio. Configuring Design Studio as the 
primary application ensures that your users cannot uninstall Design Studio.

To configure Design Studio as the primary application:

1. Open the Eclipse_Home/configuration/config.ini file, where Eclipse_Home is the 
directory in which Eclipse is installed.

2. Make the following changes:

a. Change:

osgi.splashPath = platform:/base/plugins/org.eclipse.platform

to:

osgi.splashPath = platform:/base/plugins/com.mslv.studio.branding

b. Change:

eclipse.product=org.eclipse.platform.ide

Note: Complete this procedure if you did not run the installation 
script to automatically install the Design Studio feature and to 
configure the Design Studio environment.
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to:

eclipse.product=com.mslv.studio.branding.Studio

3. Save and close the file.

4. Open the Eclipse_Home/eclipse.ini file, where Eclipse_Home is the directory in 
which Eclipse is installed. 

5. Make the following changes:

Change:

-showsplash
org.eclipse.platform 

to:

-showsplash
platform:/base/plugins/com.mslv.studio.branding

6. Save and close the file.

Configuring Update Preferences
System administrators disable access to the update sites and to automatic update 
functionality to prevent Design Studio users from updating to different feature 
versions. System administrators must ensure that the individual Design Studio users 
all work with the same set of installed features and remain on the same versions of 
those features.

To configure update preferences: 

1. Start Design Studio.

2. From the Windows menu, select Preferences.

The Preferences dialog box appears.

3. In the left column tree view, expand the Install/Update option and select 
Automatic Updates.

The Automatic Updates page appears.

4. Ensure that the Automatically find new updates and notify me option is 
deselected.

5. In the left column tree view, select Available Software Sites.

The Available Software Sites page appears.

6. Deselect all software sites.

7. Click OK.

Verifying Design Studio Feature Installation
To verify the installation:

1. Start Design Studio.

2.  From the Help menu, select About Oracle Communications Design Studio.

The About Oracle Communications Design Studio dialog box appears. 

3. Click Installation Details.
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The Installation Details dialog box appears, listing all of the features currently 
installed.

4. On the Installed Software tab, verify that the Oracle Communications Design 
Studio feature is included. 
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5Upgrading Design Studio, Productized
Cartridges, and Cartridge Packs

This chapter describes how to upgrade Oracle Communications Design Studio and 
Design Studio projects, and how to upgrade productized cartridges and cartridge 
packs.

See Design Studio Concepts for more information about working with productized 
cartridges and other predefined data models. See UIM Cartridge Guide for more 
information about cartridge packs.

Upgrading Design Studio
When upgrading Design Studio, ensure that Design Studio component and project 
backups are up-to-date. Also, determine how to upgrade projects and design 
environments for all users simultaneously. Finally, communicate changes and steps 
required by users to ensure a smooth transition.

To upgrade Design Studio:

1. Plan your upgrade. 

See "Planning the Upgrade Process" for more information.

2. Prepare for the upgrade.

See "Preparing for the Upgrade" for more information. 

3. Perform the upgrade.

See "Performing the Upgrade" for more information. 

4. Perform post-upgrade tasks.

See "Performing Post-Upgrade Tasks" for more information. 

Planning the Upgrade Process
When planning your Design Studio upgrade, consider the following:

■ Which resources need to be backed up?

Before upgrading to a new Design Studio version, back up the current Design 
Studio environment and project data files so that you can return to the current 
version, if necessary. 

■ Are all users on the same release version? 
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All individual Design Studio users should upgrade to the new version from the 
same existing version. Users working in different versions may have project 
artifacts that are not compatible with the new version. Users must upgrade to new 
versions simultaneously, and all projects must be upgraded to the new version. 
Upgraded projects are not compatible with previous versions of Design Studio.

■ What will happen if the upgrade fails? 

Errors that occur during an upgrade can create an unstable environment. Before 
beginning the upgrade process ensure that you are able to return the system to the 
initial state in the event of a failure. If an upgrade fails, collect all pertinent 
information to send to your support team, and return the system to the initial state 
prior to attempting the upgrade process again. 

See Design Studio System Administrator’s Guide for information about backing up 
and restoring Design Studio.

Preparing for the Upgrade 
When preparing for your Design Studio upgrade:

■ Define project references if you are upgrading to Design Studio (releases 7.2.4 and 
later) from releases prior to 7.2.0. See "Defining Project References" for more 
information.

■ Prepare the source control repository. See "Preparing the Source Control 
Repository" for more information.

■ Back up Design Studio projects. See "Backing Up Projects" for more information.

Defining Project References 
Upgrading to Design Studio from releases prior to 7.2.0 requires that you define 
project references (within your existing version of Design Studio) prior to the upgrade. 
Defining project references requires that you specify the dependencies for each project 
to ensure that all dependent projects are upgraded in the correct order. See the Design 
Studio Help in your previous version of Design Studio for information about defining 
project references.

Before upgrading, restructure your projects to reduce or eliminate mutual and cyclic 
dependencies. Mutual or cyclic project dependencies may cause problems during 
upgrade. You can determine project dependencies by closing a project, performing a 
clean build, and reviewing the broken reference problem markers that highlight 
cross-project relationships.

To define project references before upgrading from releases prior to release 7.2.0:

1. Start your existing version of Design Studio.

2. From the Studio menu, select Show Design Perspective.

3. Click the Studio Projects tab.

4. In the Studio Projects view, select a Design Studio project.

Note: If you are upgrading Design Studio from release 7.2.0 or from 
any release subsequent to 7.2.0, existing project references should 
already be defined correctly. Oracle recommends that you verify that 
your existing project references are set up correctly prior to your 
upgrade.
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5. (Optional) If using a source control system, check-out the .project file of the 
selected project.

Many source control systems use optimistic locking and do not require an explicit 
file check-out. See the source control system documentation for details specific to 
your system.

6. In the Studio Projects view, right-click the selected project and select Properties.

The Properties dialog box appears. 

7. In the left-column menu tree, select Project References.

A list of all projects defined in the workspace appears.

8. Select all dependent projects that the source project references.

9. Click OK.

10. (Optional) If using a source control system, check-in the modified .project file of 
the selected project.

Preparing the Source Control Repository
To prepare the source control repository, ensure that all of your Design Studio users 
check-in (or discard) any uncommitted project data file changes.

To identify a clear transition point, tag or branch all Design Studio projects in the 
source control repository prior to the upgrade. This ensures that you are able to 
determine the Design Studio application version required to build previous versions of 
your cartridges and cartridge packs. Additionally, tagging or branching provides a 
clear restore point if the upgrade fails.

See the source control system documentation for tag and branch details specific to 
your system.

Backing Up Projects
Back up all projects before upgrading Design Studio. Ensure that you include all 
Design Studio components and project data files (preferably in source control). Instruct 
your individual Design Studio users to export the workspace preferences that they 
want to restore in a new workspace.

See Design Studio System Administrator’s Guide for information about backing up 
Design Studio.

Performing the Upgrade
Upgrade Design Studio for all users and build systems simultaneously. Projects 
opened in a new version will be upgraded for use in the new version and will no 
longer work predictably in old versions.

To upgrade Design Studio:

1. Obtain a new Design Studio software package.

Note: Oracle recommends that you use a source control system. See 
Design Studio Developer’s Guide for information about incorporating 
source control into your backup strategy.
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■ Design Studio software packages for new releases are available on the Oracle 
software delivery website:

http://edelivery.oracle.com

■ Design Studio software packages for patches are available on the My Oracle 
Support website:

https://support.oracle.com

2. Install the new version to a new location.

Installing to a new location minimizes conflicts that can occur when installing over 
an existing installation. Make the new installation available to all users and update 
automated build systems to point to the new location. See "Installing and 
Configuring Design Studio" for more information.

3. Create a new distributable archive file for your users.

4. Upgrade Design Studio projects.

See "Upgrading Projects" for more information. 

5. Instruct users to download the new distributable archive file and extract it to a 
new location.

6. Instruct users to create new workspaces with upgraded projects.

7. Upgrade Design Studio build systems to use the new version.

Upgrading Projects
You must perform a one-time upgrade of your projects. Additionally, you must obtain 
and import the latest versions of all sealed productized cartridges if you want to use 
the cartridges in the updated version.

When upgrading projects, you may be required to update cartridge project target 
versions, depending on the version for which your existing cartridge projects are built 
and the version of Design Studio to which you are upgrading. The project target 
version indicates the version of the run-time application instance to which the 
cartridge project will be deployed. Design Studio builds your project to be compatible 
with the run-time software version you specify on the Project editor Properties tab. See 
the Design Studio Help for more information about the Project editor and for more 
information about the Target Version field. See your application documentation for 
information about application server version compatibility and for target version 
instructions specific to each application.

During the upgrade process, Design Studio automatically detects old project versions 
and completes all necessary project upgrades in the workspace. When the upgrade 
process completes, Design Studio saves the information about the upgrade process in 
the project-dir/upgradeLog/upgrade.log file. All information about the upgrade 
process, including notifications about failed upgrades, is included in this file.

Upgraded projects are not compatible with previous Design Studio versions. Ensure 
that you upgrade copies of projects or use source control. Project upgrades should be 
performed once by a single team member. The upgraded project should then be 
distributed to other users.

Note: Before you upgrade projects created in versions prior to 
Design Studio release 7.2.0, you must define all project references in 
your original version of Design Studio. See "Defining Project 
References" for more information. 
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To upgrade projects:

1. Complete all upgrade preparation steps.

See "Preparing for the Upgrade" for more information.

2. Check-out all project data files from the source control system.

3. Ensure that the project data files are writable.

Some source control systems use an optimistic locking strategy and require no 
additional steps for implicit check-outs. Other source control systems may require 
explicit check-out of each project data file. See the documentation specific to your 
source control system for more information.

4. Start Design Studio and create a new workspace.

Because workspaces contain caching and version-specific content, Oracle 
recommends that you create a new workspace when upgrading.

5. Determine the order in which you will upgrade the projects.

Start with projects with no dependencies. Upgrade dependent projects first or in 
conjunction with those projects that define dependencies. 

6. Start the upgrade.

You start the upgrade process any time you open a project that requires an 
upgrade to the current Design Studio version. For example, you start the upgrade 
process when you:

■ Start Design Studio

■ Switch workspaces

■ Open a closed project

■ Import projects with the Design Studio import wizard

If an open project requires an upgrade, the Upgrade Project wizard appears, listing 
all projects and dependent projects that require an upgrade. 

7. Confirm that the projects are in the correct order.

If the projects are not upgraded in the proper order, the upgrade process can fail 
and leave the project in an unknown state. Design Studio determines the correct 
order in which to upgrade the projects based on the dependencies defined for the 
project (the lowest project in the dependency hierarchy is upgraded first). If you 
have not properly defined the project dependencies, you must manually set up the 
proper order.

If the projects are not in the correct order, do one of the following:

■ Select a project and click Move Up or Move Down to change the order of the 
projects.

■ Cancel the upgrade process, return to your previous version of Design Studio, 
and define the project dependencies.

See "Defining Project References" for information about how to define project 
references. 

8. (Inventory projects only) Click Next.

When upgrading Design Studio for Inventory and Design Studio for Network 
Integrity projects, the wizard displays any characteristics that require a name 
change.
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9. (Inventory projects only) Click Next and then select the Target Version.

Cartridge project target versions specify the version of the run-time application 
instance to which a cartridge project will be deployed. Design Studio builds your 
project to be compatible with the run-time software version specified in this field. 
After you import a project, you can change the Target Version value on the Project 
editor Properties tab. Design Studio automatically sets the Java execution 
environment based on the selected target version. 

10. (Design Studio Model projects in releases before Design Studio 7.3.5 only) Validate 
Design Studio Model project Technical Action entity values.

When you upgrade a Design Studio Model project that contains Technical Action 
entities, this Studio Project Upgrade wizard requires you to validate the 
information defaulted for the application role, target, and target type for each 
technical action; or, if this information is incorrect or absent, to provide it.

For each technical action, do the following:

■ Validate or select an application role. 

An application role represents a type of downstream delivery system that is 
responsible for a specific type of delivery, such as activation, supply chain 
management, work force management, and so forth. 

Design Studio obtains the application role from the Technical Action entity 
Notes tab if the value is defined as ApplicationRole=applicationrole. You can 
select a different application role value, if needed.

■ Validate or specify a target. 

A target is the resource or resource facing service that represents an instance of 
an entity in the network against which the action executes. 

Design Studio obtains the target from the Technical Action entity Notes tab if 
the value is defined as TargetSpecification=target. You can specify a different 
target value, if needed.

■ Validate or select a target type. 

For all technical actions, Design Studio defines the target type as Resource. 
You can change this value to Resource Facing Service, if appropriate.

11. Click Finish.

The upgrade process completes and the Display Upgrade Log dialog box appears.

12. Do one of the following:

■ Click Yes to review the generated upgrade log file.

■ Click No to complete the upgrade process without reviewing the generated 
log file. You can view the update logs at a later time.

13. (Optional) If the upgrade fails, review the upgrade logs to determine the cause of 
the failure, and then do the following:

a. Roll back the system to the pre-upgrade state

b. Resolve the cause for the failure

c. Retry the upgrade

14. After a successful upgrade, commit the changes to the source control system.
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Performing Post-Upgrade Tasks
After the upgrade, do the following:

1. Review and archive upgrade logs.

2. Perform a clean build of each project.

3. Initiate command-line builds on automated build systems.

4. Distribute the new Design Studio version.

5. Instruct all individual Design Studio users to import the upgraded projects into a 
clean workspace. 

6. Remove old Design Studio application installations.

Upgrading Productized Cartridges and Cartridge Packs
This section describes how to upgrade a productized cartridge or a cartridge pack to a 
new version.

About Productized Cartridge and Cartridge Pack Upgrades
Before upgrading to a new version of a productized cartridge or cartridge pack, ensure 
that the uncommitted changes for all Design Studio projects in the source control 
system are checked-in or discarded.

If your are upgrading more than one cartridge or cartridge pack, perform the 
upgrades individually. Start with projects with no dependencies. Upgrade dependent 
projects first or in conjunction with those projects that define dependencies. Ensure 
that the workspace includes all related projects during the upgrade.

Additionally, ensure that you tag or branch all Design Studio projects in the source 
control repository prior to the upgrade to identify a clear transition point. Tagging or 
branching provides a clear restoration point in the event of a failed upgrade.

Finally, ensure that a current backup is available for all Design Studio projects. See 
Design Studio System Administrator’s Guide for more information.

Upgrading Productized Cartridges and Cartridge Packs
To upgrade a productized cartridge or cartridge pack:

Note: If you cancel the project upgrade before the upgrade process 
completes (by clicking the Upgrade Project wizard Cancel button) the 
project remains open in the workspace. You must close and reopen the 
project to attempt the upgrade again before working in the project. Do 
not perform any work in a project that has failed to successfully 
complete the upgrade process. See the Design Studio Help for 
information about opening and closing projects. 

Note: When upgrading Design Studio for Inventory cartridge 
projects that include changes to tool tips or characteristic display 
names, you must redeploy the UIM application server when you 
deploy the cartridge that contains the changes.
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1. Back up the cartridge project or cartridge pack project that you intend to upgrade. 

2. Start Design Studio.

3. From the Studio menu, select Show Design Perspective.

4. From the Project menu, deselect Build Automatically. 

Temporarily disabling the automatic build prevents unnecessary builds and 
problem markers during the upgrade procedure. 

5. Click the Studio Projects tab.

6. In the Studio Projects view, right-click the project to be upgraded and select 
Delete.

The Confirm Project Delete dialog box appears. 

7. Select the Also delete contents under option.

Selecting this option removes the current version of the project from your local file 
system.

8. Click Yes.

The project content is deleted from the workspace and the local file system.

9. Right-click in the Studio Projects view and select Import, and then select Import 
Project.

The Import Projects dialog box appears.

10. Do one of the following:

■ If your project is contained in an archive file (for example, in a TAR file or ZIP 
file), select Select archive file.

■ Otherwise, select Select root directory.

11. Click Browse.

12. Locate the directory containing the new version of the project and select it.

13. Click OK.

14. In the Projects area, select the project to import.

15. Ensure that the Copy projects into workspace check box is selected.

16. Click Finish. 

The project is added to your workspace.

17. From the Project menu, select Clean.

The Clean wizard appears.

18. Select Clean all projects and then select Start a build immediately.

19. Click OK. 

A dialog box appears, showing the progress of the build activity. The projects in 
the workspace are cleaned and a full build is performed on all projects. The build 
completion time depends on the size of workspace.

20. From the Project menu, select Build Automatically.

21. Resolve warning and error markers.

New warnings and errors may appear following a project upgrade. Markers may 
be caused by changes to the data model, such as type changes, name changes, or 
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deprecation or removal of content. Use the Refactoring menu actions (such as 
Resolve and Replace With) to facilitate problem marker resolution. See the Design 
Studio Help for more information about refactoring data element names and 
locations.

22. (Optional) If using a source control system, synchronize the new versions.

See "Synchronizing Project Versions" for more information. 

Synchronizing Project Versions
If you are using a source control system to manage revisions of productized cartridges 
and cartridge packs, you can synchronize the new version.

To synchronize new project versions:

1. In Design Studio, right-click in the Studio Projects view and select Team, then 
select Share Project.

2. Follow the steps in the wizard to share the project to the same repository location 
as the previous project version.

3. Resolve conflicts following synchronization using local file and directory versions.

4. Commit content to the repository.

See your source control system documentation for information about sharing 
projects and resolving synchronization conflicts.

Upgrading Existing Cartridge Projects to the Current Release
Cartridge projects designed for a specific server release must match the preferred 
execution environment of the application server. To retarget existing cartridge projects 
for deployment to the current release application server, you must manually update 
the cartridge target version to the current release number and update the cartridge 
execution environment to the current supported Java version.

To upgrade existing cartridge projects to the current release:

1. Install Java and add entries for each installed JRE used in development.

To install Java and add Java entries:

a. Install Java. 

See "Copying Java Runtime Environment into Oracle Enterprise Pack for 
Eclipse" for more information.

b. In Design Studio, from the Window menu, select Preferences.

The Preferences page appears.

c. Select Java, and then select Installed JREs.

d. Add an entry for each JRE that you intend to use during cartridge project 
development.

2. Update the cartridge project target version.

To update the cartridge project target version:

Note: If you encounter a blocking issue, do not check-in the changes. 
If necessary, you can cancel the upgrade by rolling back to the latest 
version under source control.
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a. From the Studio Projects view, double-click a Project entity to open the entity 
in the Project editor.

b. In the Target Version field, select the current version.

3. Update the cartridge project execution environment.

To update the cartridge project execution environment:

a. From the Studio Projects view, right-click a Project entity and select Properties.

The Properties dialog box appears.

b. Select Java Build Path, and then click the Libraries tab.

c. Select JRE System Library and then click Edit.

The Editor Library dialog box appears.

d. Select the Execution environment option, and then select the current Java 
version from the list.

e. Click Finish and then click OK.

f. Perform a clean build.

See Design Studio Help for information about performing clean builds.
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AHardware Sizing Guidelines

This appendix provides guidelines for the recommended minimum hardware 
requirements to achieve daily service. Use these guidelines to calculate the required 
hardware for the Oracle Communications Design Studio users to whom you will 
distribute a preconfigured installation.

Because vendors continuously update their hardware models, check vendor websites 
for the latest models and specifications. All hardware estimates are guidelines based 
on Oracle Communications performance lab testing and deployment experience. 

Hardware Sizing Guidelines Overview
Use the following procedure to determine the recommended minimum hardware 
required to achieve daily service:

1. Review the number of ASAP atomic actions, the Order and Service Management 
(OSM) order complexity, the number of Inventory services, and the number of 
Network Integrity model entities in all of your application cartridges.

The number and type of these entities determine whether your implementation 
falls into the small, medium, or large category. See "Design Studio Implementation 
Size Definitions" for more information. 

2. Calculate your Design Studio requirement score for the implementation size.

See "Design Studio Hardware Requirement Scores" for more information.

3. Use the Design Studio hardware requirement score to determine the hardware size 
category that your installation requires.

Note: The sizing estimates contained in this appendix are based on 
the assumptions of proper application configuration and tuning, in a 
manner consistent with leading practices of Oracle Communications 
consulting and performance engineering. This information is 
provided for informational purposes only and is not intended to be, 
nor shall it be construed as a commitment to deliver Oracle programs 
or services. This appendix shall not form the basis for any type of 
binding representation by Oracle and shall not be construed as 
containing express or implied warranties of any kind. You understand 
that information contained in this appendix will not be a part of any 
agreement for Oracle programs and services. Business parameters and 
operating environments vary substantially from customer to customer 
and as such not all factors, which may impact sizing, have been 
accounted for in this appendix. 
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See "Design Studio Hardware Requirement Size Categories" for more information. 

4. Refer to the minimum hardware requirements for your hardware size category.

See "Recommended Minimum Hardware Requirements" for more information. 

Design Studio Implementation Size Definitions
Table A–1 illustrates how Oracle defines Design Studio implementation size 
definitions, based on the total number of entities of all application cartridges.

Design Studio Hardware Requirement Scores
To help determine your hardware requirements, a Design Studio requirement score is 
applied to each application implementation size. Use Table A–2 to determine your 
total Design Studio hardware requirement score.

Design Studio Hardware Requirement Size Categories
The sum of the Design Studio hardware requirement scores for all application 
cartridges determines the hardware size category for your installation. Table A–3 
displays the ranges for each hardware requirement size category. 

Table A–1 Design Studio Implementation Size Definitions

Application Cartridge Small Medium Large

ASAP number of atomic 
actions

Fewer than 50 50 to 300 More than 300

OSM order complexity 
(x1000)

Fewer than 10 10 to 75 More than 75

Inventory number of services Fewer than 30 30 to 60 More than 60

Network Integrity number of 
model entities

Fewer than 40 40 to 80 More than 80

Note: Order complexity is calculated by adding the total number of 
order data nodes and the total number of task data nodes in all OSM 
application cartridges.

Table A–2 Design Studio Requirement Scores

Application Small Cartridges Medium Cartridges Large Cartridges

ASAP 1 2 4

OSM 2 6 7

Inventory 2 4 6

Network Integrity 1 1 2

Table A–3 Hardware Requirement Size Categories

Hardware Size 
Category Small Category Medium Category Large Category

Design Studio 
Requirement Score

1 to 5 6 to 15 16 and above
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Recommended Minimum Hardware Requirements
The minimum hardware requirement recommendation for your installation is 
determined by the hardware sizing category. See the following topics for more 
information:

■ Small Hardware Sizing Category 64-Bit Hardware Requirements

■ Medium Hardware Sizing Category 64-Bit Hardware Requirements

■ Large Hardware Sizing Category 64-Bit Hardware Requirements

Small Hardware Sizing Category 64-Bit Hardware Requirements 
Table A–4 displays the minimum hardware requirements recommended for the small 
hardware sizing category.

Medium Hardware Sizing Category 64-Bit Hardware Requirements 
Table A–5 displays the hardware requirements recommended for the medium 
hardware sizing category.

Large Hardware Sizing Category 64-Bit Hardware Requirements 
Table A–6 displays the hardware requirements recommended for the large hardware 
sizing category.

Example: Determining Hardware Sizing Categories
The following example describes how to determine the hardware sizing category for 
an installation that contains ASAP, OSM, and UIM application cartridges. 

Table A–4 Minimum Hardware Requirements for the Small Hardware Sizing Category

Hardware Specifications

Processor 2.66 GHz dual-core processor

System memory 4 GB

Disk space 20 GB

Screen resolution 1024 X 768 with 256 colors minimum

Table A–5 Minimum Hardware Requirements for the Medium Hardware Sizing Category

Hardware Specifications

Processor 2.66 GHz dual-core processor

System memory 8 GB

Disk space 40 GB

Screen resolution 1024 X 768 with 256 colors minimum

Table A–6 Minimum Hardware Requirements for the Large Hardware Sizing Category

Hardware Specifications

Processor 3 GHz dual-core processor

System memory 16 GB

Disk space 80 GB

Screen resolution 1024 X 768 with 256 colors minimum
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To determine the hardware sizing category for an installation: 

1. Count the number of ASAP atomic actions in all ASAP application cartridges.

In this example, there are 151 atomic actions.

2. Determine the implementation size for your ASAP cartridges.

In this example, 151 atomic actions is equal to a medium size implementation, as 
defined in Table A–1. 

3. Calculate the Design Studio requirement score for the ASAP implementation size.

In this example, a medium size ASAP implementation receives a score of 2, as 
defined in Table A–2. 

4. Determine the OSM order complexity for all OSM application cartridges.

In this example, there are 88 order data nodes and 304 task data nodes. The order 
complexity is the sum of the order data and task data nodes, or 392.

5. Determine the implementation size for your OSM cartridges.

The order complexity is 392, which is equal to a small size implementation, as 
defined in Table A–1. 

6. Calculate the Design Studio requirement score for the OSM implementation size.

In this example, a small size OSM implementation receives a score of 2, as defined 
in Table A–2. 

7. Calculate the number of Inventory services in all Inventory application cartridges.

In this example, there are 26 Inventory services.

8. Determine the implementation size for your Inventory cartridges.

The number of Inventory services is 26, which is equal to a small size 
implementation, as defined in Table A–1. 

9. Calculate the Design Studio requirement score for the Inventory implementation 
size.

In this example, a small size Inventory implementation receives a score of 2, as 
defined in Table A–2. 

10. Calculate the number of Network Integrity model entities in all Network Integrity 
application cartridges.

In this example, there are 82 Network Integrity model entities.

11. Determine the implementation size for your Network Integrity cartridges.

The number of Network Integrity model entities is 82, which is equal to a large 
size implementation, as defined in Table A–1. 

12. Calculate the Design Studio requirement score for the Network Integrity 
implementation size.

In this example, a large size Network Integrity implementation receives a score of 
2, as defined in Table A–2. 

13. Calculate the sum of the ASAP, OSM, Inventory, and Network Integrity Design 
Studio requirement scores.

Each application implementation received a requirement score of 2, the sum of 
which is equal to 8. 

14. Determine the hardware sizing category of your installation.
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In this example, the hardware sizing category is medium, as defined in Table A–3. 

15. Review the recommended hardware sizing category minimum requirements for 
your installation.

For this example, the installation falls into the medium size hardware sizing 
category, and the recommendations are defined in Table A–5. 
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